
Please follow the instructions in this manual to obtain the optimum results from this unit.
We also recommend that you keep this manual handy for future reference.

VOICE SECURITY SYSTEM AI-900

SETUP SOFTWARE MANUAL
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1. DESCRIPTION

The PC program (AI900.EXE) described in this manual is software intended for performing the AI-900 system
setting.

1.1. System Requirements

OS: Microsoft ® Windows NT ® Workstation 4.0 Service Pack 5
CPU: Pentium ® II, 200 MHz or more
Memory: 64 MByte or more
Hard disk: Free space of 50 Mbyte or more
Monitor: Larger than 14.1 inches
Resolution: 800X600 pixel, 256 colors or more
Other: RS-232C port, 3.5-inch FDD

1.2. Installation

(1) Before starting installation, first exit all other applications and resident programs. You could not properly
perform installation if there is any program under execution. 

(2) Set the first setup disk. 
(3) Press the Start button on the task bar, and select [Run...].
(4) Enter "a:setup" in the name column and press the Enter key. Thereafter, perform installation according to

the installer's instructions. 

1.3. Start and Exit

Start: Press the Start button on the task bar and select Program -AI-900 - AI-900.
Exit: Either select File - Exit from the menu or press the Exit button. 

1.4. Uninstallation (Removal)

(1) Check to be sure that the program for the AI900 PC has not been activated.
(2) Press the Start button on the task bar, and select Settings - Control Panel.
(3) Execute Add/Remove Program and select the Install/Uninstall tab.
(4) Select AI-900 from the listing of Install/Uninstall and press the Add/Remove... button. 
(5) The screen will ask you if you delete. Press the Yes button. To abort the deletion, press the No button. 
(6) The end message will be displayed, indicating the completion of uninstallation (removal).

Note
Microsoft and Windows NT are the trade marks registered by the United States' Microsoft Corporation in the
United States and other countries. 
Pentium is the registered trade mark of Intel Corporation in the United States.
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2. PROGRAM EXECUTION AND TERMINATION

2.1. Program Execution

Start the AI900.exec program. The following password screen will be displayed if a password has been
registered. Enter the password. If the password is correct, the settings file will be read and the main screen
displayed.

If no settings file is found, the system will revert to default settings and create a new settings file.

2.1.1. Entering the password

Starting the setup program displays the following screen. This screen will not be displayed unless a password
has been registered. Use the Maintenance screen to set the password.

Password
A password of up to 20 characters can be entered for the AI900 setting software.

Password Change [New Password Change] Button
Displays the Password Change screen to permit the set password to be changed.

[OK] Button
Displays the main screen when the password is correctly entered.

[Cancel] Button
Exits the password setting screen.
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2.1.2. Changing the password  

To change the password, press the [New password Change] button. The following screen will then be
displayed.

Old Password
Enter the current password.

New Password
Enter the new password.

New Password (confirmation)
Enter the new password again.

[OK] Button
Saves the entered password, if correct.

[Cancel] Button
Exits the Setting Change mode to return the display to the Password screen.
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2.1.3. Main screen

When a password has been registered, the following screen is displayed if the correct password is entered. If
no password has been registered, the following screen is displayed instead of the Password screen.

Notes
• The [Log Data] button lights up in red when pressed. 

• The [Communication Monitoring] button lights up in red when pressed.

2.1.4. Program termination

To terminate the program, press the [Exit] button on the main screen or choose [Quit Application] from the File
menu.

Notes
• A warning message appears if an attempt is made to terminate the program while log data or

communication monitoring is requested. In such cases, choose the [Stop] button to terminate the request.

• A warning message appears if an attempt is made to terminate the program without saving changes to the
settings file.
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3. STORING DATA AND READING DATA FILES

3.1. Data Storage ([Save As] menu)

To save entered data to disk, choose [Save As] from the [File] menu on the main screen. The following screen
will then be displayed:

Filename
Enter the filename to save data to.

[Save] Button
Saves data to disk.

[Cancel] Button
Cancels current operation and returns the display to the main screen.

3.2. Overwriting ([Save] menu)

To save changes made to an existing data file, choose [Save] from the [File] menu on the main screen. When
there is no filename (i.e. when [New File] is selected from the [File] menu on the main screen), the [Save As]
menu is displayed. Enter the new filename and store the file.

Notes
• Overwriting a file already stored on the [Save As] menu updates that file.

• When a filename is designated on the [Open] menu, the designated file is updated when overwritten.

• Overwriting an unnamed data file updates the file with a default name assigned.
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3.3. Opening Data Files

To open files stored on disk, choose [Open] from the [File] menu. The following screen will then be displayed.

Filename
Designate the name of the file to open.

[Open] Button
Reads the file from disk.  

[Cancel] Button
Cancels current operation and returns the display to the main screen.

3.4. Creating a New File

To create new default settings, choose [New File] from the [File] menu on the main screen. Creating a new file
over the data being edited will delete that data. 
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4. PRINTING

4.1. Printing

To print setting data, choose [Print] from the [File] menu on the main screen. The following screen will then be
displayed:

Printer Name
Set the name of the printer to use.

[OK] Button
Prints all setting data. (However, Direct Select Dial settings are not printed.)

[Cancel] Button
Cancels current operation and returns the display to the main screen.
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5. HELP

5.1. Version Information

To display information on the AI900's version, choose [AI900 Version Information] from the [Help] menu on
the main screen. The following screen will then be displayed:

[OK] Button
Returns the display to the main screen.
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6. DATA SETTING

6.1. System Setting

6.1.1. System Setting

This menu is used for all system settings. Pressing the [System] button on the main screen displays the
following screen:

Current Time
Indicates the current time (hour/minute/second).

Number of Exchanges [No. of Exchanges:]
Designates the number of exchanges to be used in the entire system (1 – 16).

Station Number Digit [Station digits:]
Sets the digit length (2 – 6) to be used to label the system's station numbers.

Tie-Line Connection Line
Designates whether or not to use tie-line connection lines 1 – 4.

Exchange setting (table)

Exchange Number [Exchange]
Indicates each of the connected exchanges (1 – 16).

First Station Number
Sets the first substation number to be connected to each exchange. The station number range depends on
the set station number digit length.

Note
When the number of exchanges decreases, the corresponding exchange is deleted from the table. When
the number of exchanges increases, set the first station number for the corresponding exchange.
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[Print] Button
Prints currently edited data. Note that the currently edited data are not yet stored.

[Upload] Button
Displays the confirmation message. Pressing the [OK] button changes the exchange settings and
stores any changes. When the [Cancel] button is pressed, the currently edited data is not transmitted to
the computer.

[Overwrite] Button
Saves set data.

[Close] Button
Cancels current operation and returns the display to the main screen. Data input is abandoned.
However, a warning message is displayed when changes are made.

Note
Pressing the [Upload] or [Overwrite] button permits confirmation of the following settings:

(1) Duplication of the first station number
(2) Digit length of the first station number can be checked.
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6.2. Line Setting

6.2.1. Station setting

[Master station/telephone setting]

To perform the master station/telephone setting, press the [Stations] button. The following screen will then be
displayed.

Exchange Designation

Exchange Number
Selects individual exchange numbers (No. 1-up to the total number of exchanges, or ALL).

Master Station/Telephone Setting (table) 

Note
Four stations are always displayed per exchange. (When "ALL" is selected, settings of all exchanges in the
set number are simultaneously displayed.)

Exchange Number [Exchange]
Displays the exchange number.

Line Number [Line] 
Displays the line number. (1 – 4) 

Station Number [Station]
Sets the station number. Each station number must be of the same digit length set on the System
Setting screen.

Station Name [Name]
A name of up to 8 alphanumeric characters can be entered. When the station number is entered, the
same number is automatically displayed as a default station name.

Access to Outgoing Calls [C/O Line Access]
Sets whether or not each station is permitted access to the telephone line.
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Emergency Paging [Emergency Paging]
Sets whether or not each station is permitted access to Emergency paging.

Outside Line Call Forwarding Receiving Telephone Number [C/O Call Forwarding]
Sets the receiving telephone number to which telephone calls are automatically rerouted. (Up to 20
digits)

Note
Enter a hyphen ( - ) when using a pause in the telephone number.

Manual Call Forwarding Receiving Station [Call Forwarding]
Set the master station number or an outside line access number to receive manually-forward calls. The
station numbers connected to all exchanges can be programmed. The outside line access number must
be identical to that which has been assigned to the exchange the corresponding master station is
connected to. It is also possible not to designate any receiving station by pressing the Enter key.

Time-Based Call Forwarding Receiving Station [Time-Based Call Forwarding]
Set the master station number or an outside line access number to receive calls automatically
forwarded while the system is in Time-Based Forwarding mode. The station numbers connected to all
exchanges can be programmed. The outside line access number must be identical to that which has
been assigned to the exchange the corresponding master station is connected to. It is also possible not
to designate any receiving station by pressing the Enter key.

Busy Call Forwarding Receiving Station [Busy Call Forwarding]
Set the master station number or an outside line access number to receive calls automatically
forwarded while the system is in Busy Call Forwarding mode. The station numbers connected to all
exchanges can be programmed. The outside line access number must be identical to that which has
been assigned to the exchange the corresponding master station is connected to. It is also possible not
to designate any receiving station by pressing the Enter key. 

No-Answer Call Forwarding Receiving Station [No-Answer Call Fwd]
Set the master station number or an outside line access number to receive calls automatically
forwarded while the system is in No-Answer Call Forwarding mode. The station numbers connected to
all exchanges can be programmed. The outside line access number must be identical to that which has
been assigned to the exchange the corresponding master station is connected to. It is also possible not
to designate any receiving station by pressing the Enter key.

Notes
• Stations can be maed inoperative by pressing the [Del] key while the corresponding line is selected.

• All setting data for such invalidated stations, except exchange and station numbers, will be erased.

• Invalid stations may be located between valid stations.
Example: Equipment No. 1: Valid; No. 2: Valid; No. 3: Invalid; No. 4: Valid; etc.

[Print] Button
Prints currently edited data. Note that the currently edited data is not yet stored.

[Upload] Button
Displays the confirmation message. Pressing the [OK] button changes the exchange settings and
stores any changes. When the [Cancel] button is pressed, the currently edited data is not transmitted to
the computer.

[Overwrite] Button
Saves set data.

[Close] Button
Cancels current operation and returns the display to the main screen. Data input is abandoned.
However, a warning message is displayed when changes are made.

Note
Pressing the [Upload] or [Overwrite] button permits confirmation of first station number duplication.
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[Substation setting]

To perform the substation setting, press the [Stations] button on the main screen, and then the [Substation]
button. The following screen will then be displayed.

Exchange Designation

Exchange Number
Selects the exchange number. (No.1-up to the total number of exchanges, or ALL)

Substation Setting (table)

Note
Sixty-four stations are always displayed per exchange. (When "ALL" is selected, settings of all exchanges in
the set number are simultaneously displayed.)

Exchange Number [Exchange]
Displays the exchange number.

Line Number [Line]
Displays the line number. (1 – 64)

Substation Number [Station]
Sets the station number with in the range beginning at the selected exchange's first designated station
number and ending at the number immediately preceding the next exchange's first station number.
(Refer to the system setting.)

Substation Name [Name]
A name of up to 8 alphanumeric characters can be entered.

Called Station Exchange Number [Called Exchange]
Sets the exchange number to which all master station/telephone calls will be connected.

Called Station Line Number [Called Line]
Sets the called master station/telephone line number.
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Called Station Number [Called Station]
Sets the called master station/telephone number.

Called Station Name [Called Name]
Sets the called master station/telephone name.

Call Priority [Call Priority]
Selects the call priority level: Normal or Emergency.

Notes
• Inoperative stations can be invalidated by pressing the [Del] key while the corresponding line is selected.

• All setting data for such invalidated stations, except exchange and station numbers, will be erased.Invalid
stations may be located between valid stations.

• Invalid stations may be located between valid stations.
Example: Equipment No. 1: Valid; No. 2: Valid; No. 3: Invalid; No. 4: Valid; etc.

[Print] Button
Prints currently edited data. Note that the currently edited data is not yet stored.  

[Upload] Button
Displays the confirmation message. Pressing the [OK] button changes the exchange settings and
stores any changes. When the [Cancel] button is pressed, currently edited data is not transmitted to the
computer.

[Overwrite] Button
Saves set data.

[Close] Button
Cancels current operation and returns the display to the main screen. Data input is abandoned.
However, a warning message is displayed when changes are made.

Note
Pressing the [Upload] or [Overwrite] button permits confirmation of first station number duplication.
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6.2.2. Outside line setting

To perform the outside line setting, press the [C/O Trunks] button. The following screen will then be displayed.

Exchange Designation

Exchange number
Selects the exchange number. (No. 1-up to the total number of exchanges.)

Outside Line Connection Time-Out 

Outside Line Connection Time-Out  [C/O Time-Out (1 – 99min)]
Sets a fixed time limit for telephone conversations. (1 – 99 minutes)

C/O Line (1 and 2) settings

Name
Sets the name of the line.

Outgoing Call Access Number
Sets the access number for outgoing calls on the external line (0 – 9). Note that this setting is invalid for
those stations designated as "receiving-only."

Direct-In Dialing [Incoming (Direct-in dial)] 
Selects this service.

Direct-In Line [Incoming (Direct-in line)] 
Selects this service.
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Receiving Station [Rcv Station]
When using the Direct-In line service, set a receiving station group consisting of a representative station
[Rep] and 1 to 3 member stations. To set the stations, designate both the exchange and line numbers
for each master station (telephone). The station number and its name will then be displayed for the set
master station (telephone).

Note
The contents of a selected line can be deleted with the [Del] key.

[Delete ALL] Button
Displays the confirmation message. Pressing the [OK] button deletes and stores all of the above
receiving station settings. The depression of the [Delete ALL] button can be canceled by pressing the
[CANCEL] button.

[Print] Button
Prints currently edited data. Note that the currently edited data is not yet stored. 

[Upload] Button
Displays the confirmation message. Pressing the [OK] button changes the exchange setting and stores
the change. When the [Cancel] button is pressed, the currently edited data is not transmitted to the
computer. 

[Overwrite] Button
Saves set data.

[Close] Button
Cancels current operation and returns the display to the main screen. Data input is abandoned.
However, a warning message is displayed when changes are made to the settings of Lines 1 and 2.

Note
Pressing the [Upload] or [Overwrite] button permits confirmation of the following settings:

(1) Representative station setting.
(2) Master stations (telephones) number duplication.
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6.3. Function Setting

6.3.1. Group Call setting

To perform the Group Call setting, press the [Group Call] button on the main screen. The following screen will
then be displayed.

Exchange Designation

Exchange Number
Sets the exchange number to use. (No. 1-up to the total number of exchanges)

Master Station/Telephone line Number
Selects the line number (No. 1 – No. 4) of the master station. (telephone)

Master Station/Telephone Designation (table)

Note
Fifteen stations are always displayed. 

Exchange Number [Exchange]
Sets the exchange number (No. 1 – No. 16) of the master station or telephone.

Line Number [Line]
Sets the Line number (No. 1 – No. 4) of the master station (telephone).

Station Number [Station]
Displays the station number of the master station (telephone).

Station Name [Name]
Displays the name of the master station (telephone).

Note
The contents of a selected line can be deleted with the [Del] key.
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[Delete ALL] Button
Displays the confirmation message. Pressing the [OK] button deletes and stores all of the above master
station/telephone settings. The depression of the [Delete ALL] button can be canceled by pressing the
[CANCEL] button.

[Print] Button
Prints currently edited data. Note that the currently edited data is not yet stored.

[Upload] Button
Displays the confirmation message. Pressing the [OK] button changes the exchange settings and
stores any changes. When the [Cancel] button is pressed, the currently edited data is not transmitted to
the computer.

[Overwrite] Button
Saves set data.

[Close] Button
Cancels current operation and returns the display to the main screen. Data input is abandoned.
However, a warning message is displayed when changes are made to the master station/telephone
setting.

Note
Pressing the [Upload] or [Overwrite] button permits confirmation of duplication of the stations having the
same exchange and equipment numbers in a single station group.
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6.3.2. Call Forwarding/Time-Out settings

Pressing the [Forwarding/Time-Out] button on the main screen displays the following screen:

Exchange Designation

Exchange Number
Selects the exchange number. (No. 1-up to the total number of exchanges)

Function Setting

Call Forwarding [Call Forwarding]
Enable/Disables the Call Forwarding function. Checking off the box makes this function available.

Time-Based Call Forwarding [Time-Based Call Forwarding]
Enables/Disables the Time-Based call forwarding function by its start and end times.

Start Time
Sets the hour and minute the call forwarding interval will begin. (00:00 – 23:59)

End Time
Sets the hour and minute the call forwarding interval will end. (00:00 – 23:59)

Busy Call Forwarding [Busy Call Forwarding]
Enables/Disables the Busy Call Forwarding function. If the box is checked off, calls received while the
station line is busy are transferred.

No-Answer Call forwarding [No-Answer Call Fwd] 
Enables/Disables the No-Answer Call forwarding function. If the box is checked off, calls are transferred
when no response is detected within the preset interval.

Calling Interval [Interval (1 – 99s)]
Sets the stations calling interval for calling interval limitation. (1 – 99 seconds)

Call Time-Out [Call Time-Out]
Enables/Disables the call time-out function. If the box is checked off, calls are terminated when no
response is made within the preset interval.

Time Limit [Time Limit (1 – 99min)]
Sets the stations calling interval for calling interval limitation (1 – 99 minutes).
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Conversation Time-Out [Conversation Time-Out]
Enables/Disables the station conversation time limiter. If the box is checked off, conversations are
automatically terminated when the time limit is reached.

Time Limit [Time Limit (10 – 990s)] 
Sets the conversation time limit (10 – 990 seconds).

[Print] Button
Prints currently edited data. Note that the currently edited data is not yet stored.

[Upload] Button
Displays the confirmation message. Pressing the [OK] button changes the exchange settings and
stores any changes. When the [Cancel] button is pressed, the currently edited data is not transmitted to
the computer.

[Overwrite] Button
Saves set data.

[Close] Button
Cancels current operation and returns the display to the main screen. Data input is abandoned.
However, a warning message is displayed when changes are made. 
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6.3.3. Scan Monitor setting

To set the scan monitor group, press the [Scan Monitor] button on the main screen. The following screen will
then be displayed.

Exchange Designation

Exchange Number
Selects the exchange number (No. 1-up to the total number of exchanges).

Master Station Line Number
Selects the line number (1 – 4) of the master station.

Monitoring Time

Monitoring Time [Monitor Time (1 – 99s)] 
Sets the scan-monitor time interval (1 – 99 seconds).

Substation Settings (table)

Note
Sixteen substations are always displayed per exchange.

Exchange Number [Exchange]
Sets the number of the exchange to which the substation is connected (1 – 16).

Line Number [Line]
Sets the substation equipment number. (1 – 64)

Substation Number [Station]
Sets the substation number.
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Substation Name [Name]
Sets the substation name.

Note
The contents of a selected line can be deleted with the [Del] key.

[Delete ALL] Button

Displays the confirmation message. Pressing the [OK] button deletes and stores all of the above
substation settings. If the [CANCEL] button is pressed, the depression of the [Delete ALL] button is
canceled.

[Print] Button

Prints currently edited data. Note that the currently edited data is not stored.

[Upload] Button

Displays the confirmation message. Pressing the [OK] button changes the exchange settings and
stores any changes. When the [Cancel] button is pressed, the currently edited data is not transmitted to
the computer.

[Overwrite] Button

Saves set data.

[Close] Button

Cancels current operation and returns the display to the main screen. Data input is abandoned.
However, a warning message is displayed when changes are made.  

Note
Pressing the [Upload] or [Overwrite] button permits checking for duplicate stations with the same exchange
and equipment numbers in a single station group.
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6.3.4. Paging setting

[Paging setting]

To perform the paging setting, press the [Paging] button on the main screen. The following screen will then be
displayed.

Exchange Designation

Exchange Number
Selects the exchange number (No. 1-up to the total number of exchanges).

Zone Designation

Zone Number Digit [Zone Digit (1 or 2 digits):]
Selects the length of the digit to be used to label the paging zone numbers (1 – 2).

Paging Time Designation

Paging Time-Out
Sets a paging time limit (10 – 990 seconds).

Substation Settings (table)

Note
Nineteen zones are always displayed per exchange. 

Exchange Number [Exchange]
Displays the exchange number to which the substation is connected.

Line Number [Line]
Displays the substation's equipment number.

Substation Number [Station]
Displays the substation number.
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Substation Name [Name]
Displays the substation's name.

Zone
Up to 19 zones can be created.

V: Already registered.
–: Not yet registered.
X: Cannot be registered.

Substations assigned an "Urgent" priority level in the substation setting.
Invalid substations.

Note
Substations can be made inoperative by selecting the corresponding line and pressing the [Del] key.

[Print] Button

Prints currently edited data. Note that the currently edited data is not yet stored.

[Upload] Button

Displays the confirmation message. Pressing the [OK] button changes the exchange settings and
stores any changes. When the [Cancel] button is pressed, the currently edited data is not transmitted to
the computer.

[Overwrite] Button

Saves set data.

[Close] Button

Cancels current operation and returns the display to the main screen. Data input is abandoned.
However, a warning message is displayed when changes are made.
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[Public address equipment setting]

To perform the public address equipment setting, first press the [Paging] button on the main screen, and then
the [Public Address System] tab. The following screen will then be displayed.

Exchange Designation

Exchange Number
Selects the exchange number (No. 1-up to the total number of exchanges).

Equipment Designation (table)

Note
Nineteen zones are always displayed per exchange.

Exchange Number [Exchange]
Displays the exchange number to which public address equipment are connected.

Line Number [Line]
Displays the line number (PA01 – PA16) of the public address equipment.

Zone
Up to 19 zones can be created.

V: Already registered.
–: Not yet registered.

Note
Substations can be made inoperative by selecting the corresponding line and pressing the [Del] key.
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[Print] Button
Prints currently edited data. Note that the currently edited data is not yet stored.

[Upload] Button
Displays the confirmation message. Pressing the [OK] button changes the exchange settings and
stores any changes. When the [Cancel] button is pressed, the currently edited data is not transmitted to
the computer.

[Overwrite] Button
Saves set data.

[Close] Button
Cancels current operation and returns the display to the main screen. Data input is abandoned.
However, a warning message is displayed when changes are made.
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[External Source Distribution]

To perform the external source distribution setting, first press the [Paging] button on the main screen, and
then the [External Source Distribution] tab. The following screen will then be displayed.

Exchange Designation

Exchange Number
Selects the exchange number (No. 1-up to the total number of exchanges).

Equipment Designation (table)

Note
Nineteen zones are always displayed per exchange.

Exchange Number [Exchange]
Displays the exchange number to be used for external input.

Control Input [Ctrl In]
Displays external inputs for external source distribution (Channels 1 – 4).

Zone
Up to 19 zones can be created.

V: Already registered.
–: Not yet registered.

Note
Substations can be made inoperative by selecting the corresponding line and pressing the [Del] key.
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[Print] Button
Prints currently edited data. Note that the currently edited data is not yet stored.

[Upload] Button
Displays the confirmation message. Pressing the [OK] button changes the exchange settings and
stores any changes. When the [Cancel] button is pressed, the currently edited data is not transmitted to
the computer.

[Overwrite] Button
Saves set data.

[Close] Button
Cancels current operation and returns the display to the main screen. Data input is abandoned.
However, a warning message is displayed when changes are made.
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6.3.5. Emergency Conference setting

Pressing the [Emergency Conference] button on the main screen displays the following screen. Set the
Emergency Conference station group on this screen.

Exchange Designation

Exchange Number
Selects the exchange number (No. 1-up to the total number of exchanges).

Master Station (Telephone) Line Number
Selects the line number of the master station (telephone) (1 – 4).

Master station(Telephone) Settings (table)

Note
Three stations are always displayed per exchange.

Exchange Number [Exchange]
Sets the exchange number to which the master station (telephone) is connected (1 – 16). Exchange
Number - Sets the exchange number to which the master station (telephone) is connected (1 – 16).

Line Number [Line]
Sets the line number of the master station(telephone) (1 – 4).

Station Number [Station]
Sets the station number of the master station (telephone).

Station Name [Name]
Sets the name of the master station (telephone).

Note
The contents of a selected line can be deleted with the [Del] key.
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[Delete ALL] key
Displays the confirmation message. Pressing the [OK] button deletes and stores all of the above master
station/telephone settings. The depression of the [Delete ALL] key is canceled by pressing the
[CANCEL] key.

[Print] Button
Prints currently edited data. Note that the currently edited data is not yet stored.

[Upload] Button
Displays the confirmation message. Pressing the [OK] button changes the exchange settings and
stores any changes. When the [Cancel] button is pressed, the currently edited data is not transmitted to
the computer.

[Overwrite] Button
Saves set data.

[Close] Button
Cancels current operation and returns the display to the main screen. Data input is abandoned.
However, a warning message is displayed when changes are made to the master station/telephone
designation.

Note
Pressing the [Upload] or [Overwrite] button permits confirmation of duplicate stations with the same
exchange and equipment numbers in a single station group.
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6.3.6. Direct Select setting

To perform the Direct Select setting, press the [Direct Select] button on the main screen. The following screen
will then be displayed.

Exchange Designation

Exchange Number
Selects the exchange number (No. 1-up to the total number of exchanges).

Control Output Mode Designation

Control Output Mode [Control Output:]
Selects the external equipment control output operation mode ("make contact" when conversation
begins or when calls are initiated).

[Print] Button
Prints currently edited data. Note that the currently edited data is not yet stored.

[Upload] Button
Displays the confirmation message. Pressing the [OK] button changes the exchange settings and
stores any changes. When the [Cancel] button is pressed, the currently edited data is not transmitted to
the computer.

[Overwrite] Button
Saves set data.

[Close] Button
Cancels current operation and returns the display to the main screen. Data input is abandoned.
However, a warning message is displayed when changes are made.
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6.4. Maintenance/Control Functions Setting

6.4.1. Remote Dialing

To perform the Remote Dialing Setting, press the [Remote Dialing] button on the main screen. The following
screen will then be displayed.

Remotely Controlled Station Designation

Exchange Number [Exchange]
Selects the exchange number (No. 1-up to the total number of exchanges).

Master station line Number [Master Station No.]
Selects the equipment number (1 – 4) of the master station (telephone) to be remotely controlled by the
system PC.

Dialing Data

Dialing Data [Dialing Data]
Sets the telephone number (up to 32 digits) to be dialed from the PC-operated station. The 5 most
recently registered telephone numbers are displayed.

Note
Enter a hyphen ( - ) when using a pause in the telephone number.

[Dial] Button
Transmits dial data to the exchange. 

[Cancel] Button
Cancels current operation and returns the display to the main screen. Data input is abandoned.
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6.4.2. Log Data

Pressing the [Log Data] button on the main screen displays the following screen. Perform settings for the
requested exchange to send log data. The log data is stored in files, and received data is displayed.

Request for Log Data

Pull down the exchange number box to select the exchange number.

Notes
· Choosing "ALL" displays all exchange data.
· Choosing "RESET" restores the display to the original state.

Pressing the [Select] button instructs the exchange to transmit data.

Automatic Log Data Storage

Received data is automatically stored in a file in 64 kB units. All filenames are written in the following
format: HSyymmdd-xx.txt.
For example, if the files are created on January 7, 2000, the filenames would be: HS000107-01.txt,
HS000107-02.txt, etc. The "xx" indicates consecutive numbers.

Manual Log Data Storage

The [Data Save] button can be used while received data are displayed, and the displayed data are saved
in files. After they have been saved in files, the [Data Save] button cannot be used until new log data is
received. The filename format is HSyymmddhhmmss.txt.
For example, i f  the f i le is saved at 14:05:27 on January 7, 2000, the f i lename would be
HS000107140527.txt.

Destination

By pressing the [Destination] button, the file in which data are manually saved can be changed.

Log data display

Displays the most recent 1000 lines of log data.

[Print] Button
Prints log data displayed on the screen.
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Shown below are log data display examples.

[Close] Button
Exits the log data screen.



38

6.4.3. Communication Monitoring

Pressing the [Communication Monitoring] button on the main screen displays the following screen. Perform
settings for the requested exchange to send communication monitoring data. The monitoring data is stored in
files, and received data is displayed.

Request for Communication Monitoring data

Pull down the exchange number box to select the exchange number. 

Notes
· Choosing "ALL" displays all exchange data.
· Choosing "RESET" restores the display to the original state.  

Pressing the [Set] button instructs the exchange to transmit data.

Automatic Communication Monitoring Data Storage

Received data is automatically stored in a file in 64 kB units. All filenames are written in the following
format: CMyymmdd-xx.txt.
For example, if the files are created on January 7, 2000, the filenames would be CM000107- 01.txt,
CM000107-02.txt, etc. The "xx" indicates consecutive numbers.

Manual Communication Data Storage

The [Data Save] button can be used while received data are displayed, and the displayed data are saved
in files. After they have been saved in files, the [Data Save] button cannot be used till new log data is
received. The filename format is CMyymmddhhmmss.txt. 
For example, i f  the f i le is saved at 14:05:27 on January 7, 2000, the f i lename would be
CM000107140527.txt.

Destination

By pressing the [Destination] button, the file in which data are manually saved can be changed.
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Communication Monitoring data display

Displays the most recent 1000 monitoring data.

[Print] Button
Prints communication monitoring data displayed on the screen.

[Close] Button
Exits the communication monitoring data screen.

Shown below are communication monitoring data display examples.
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6.4.4. Upload/Download

[Data Upload]

To perform the setting of the exchange to which setting data are transmitted, press the [Upload/Download]
button on the main screen. The following screen will then be displayed.

Selection of [Single] displays the following screen:

All Exchanges [All]
Transmits setting data to all exchanges set in the number of exchanges in the system setting.

Designated Exchanges [Single]
Transmits setting data to the exchange designated in the exchange number selection box.

Exchange number
Designates the exchange number by choosing from the set total number of exchanges while [Exchange
No.] is selected.

[Upload start] Button
Displays the confirmation message. Pressing the [OK] button changes the exchange settings. When the
[Cancel] button is pressed, the setting data is not transmitted to the computer. 

[Exit] Button
Returns the display to the main screen.
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[Data Download]

To perform the setting of the exchange from which setting data are received, press the [Upload/Download]
button on the main screen, and then the [Data Download] button. The following screen will then be displayed.

Selection of [Single] displays the following screen:

All Exchanges [All]
Receives setting data from all exchanges.

Designated Exchanges [Single]
Receives setting data from the exchange designated in the exchange number selection box.

Exchange number
Designates the exchange number by choosing from the set total number of exchanges while [Exchange
No.] is selected.

[Download start] Button
Receives setting data from the designated exchange and stores the data in the system PC.

[Exit] Button
Returns the display to the main screen.

Note
Received data overwrites the currently edited data. Therefore, execute this function when any problem is
not foreseen even if the data is received (for example, after new data is created).
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6.4.5. Printout

To perform the setting of the exchange the setting data of which is printed, press the [Printout] button. The
following screen will then be displayed.

Selection of [Designated Xch] displays the following screen:

All Exchanges 
Prints setting data of all exchanges.

Designated Exchanges Exchange number
Prints setting data of the designated exchange. Designates the exchange number by choosing from the
set total number of exchanges while [Exchange No.] is selected.

[Print start] button
Prints setting data of the set exchange. 

[Cancel] Button
Returns the display to the main screen.

Note
The data of the Direct Select Dial function is not printed.
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The following screen assumes that the communication connection method is set for "Modem."

PC/exchange communication connection setting

Connection Method
Selects the method of connection to the exchange (RS-232C or Modem).

COM Port
Selects the communication port in the event of RS-232C connection.

Telephone Number [Telephone]
Sets the telephone number in the event of Modem connection.

Note
Enter a hyphen ( - ) when using a pause in the telephone number.

6.4.6. PC Port Setting

To perform the maintenance setting, press the [PC Port] button on the main screen. The following screen will
then be displayed.

The following screen assumes that the communication connection method is set for "RS-232C."
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6.5. AI-900DI Settings

6.5.1. Dialing Assignment

To perform the Direct Select Dial setting, press the [Dialing Assignment] button on the main screen. The
following screen will then be displayed.

Exchange Designation

Exchange Number
Selects the exchange number (No. 1-up to the total number of exchanges).

Master Station Line Number
Selects the master station line number (1 – 4).

One Shot Make Time
Sets the one-shot make duration (1 – 9 sec).

Password Change [New Password] Button
Displays the Password Change screen to permit the set password to be changed. (Refer to Section
1.1.2. on p. 4.)

[Overwrite] Button
Saves set data.

[Close] Button
Cancels current operation and returns the display to the main screen. Data input is abandoned.
However, a warning message is displayed when changes are made.
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Dial Designation (table)

Note
One rhousand and twenty-four switches are always displayed per exchange.

Dial Data [Dial]
Sets the number (1 – 16 digits) to dial. 

Name [Name]
Sets the master or substation name.

Door Lock (Switch No.) [Door Lock (Switch No.)]
Sets the control number (switch number) for the door lock remote operation.

Note
The contents of a selected line can be deleted with the [Del] key.

[Delete ALL] Button
Displays the confirmation message. Pressing the [OK] button deletes and stores all of the above dial
settings. The depression of the [Delete ALL] button is canceled by pressing the [Cancel] button.

[Download] Button
Receives dial data of all switches from the exchange and stores those data in the system PC. Currently
edited PC data is abandoned.

[Print] Button
Prints currently edited data. Note that the currently edited data is not yet stored.

[Upload] Button
Displays the confirmation message. Pressing the [OK] button changes the exchange settings and
stores any changes. When the [Cancel] button is pressed, the currently edited data is not transmitted to
the computer.

[Overwrite] Button
Saves set data.

[Close] Button
Cancels current operation and returns the display to the main screen. Data input is abandoned.
However, a warning message is displayed when changes are made.
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7. DATA SETTING RANGES AND INITIAL VALUES

7.1. System Setting

Function Item Unit Setting Range Initial Value

System Setting

Number of exchanges Entire system 1 – 16 1

Station Number Digit Entire system 2 – 6 2

Tie-Line Connections Entire system Enabled/disabled Disabled

Exchange Station
Number assignment

Exchange Depends on the station
number digit length.
2 digits: 10 – 99

10

Subject Item Unit Setting Range Initial Value

Master Station
/Telephone

Station Number Master Station 00 – 999999
Depends on the station number
digit.

90 – 93

Station Name Master Station 8 alphanumeric characters Station No.

Access to Outgoing
Calls

Master Station Enable (V)/Disabled (–) (–)

Emergency Paging Master Station Enable (V)/Disabled (–) (–)

7.2. Line Setting

"Outside Line Calls 
Forwarding" Receiving
Telephone Number

Master Station Up to 20 digits No setting

"Call Forwarding" 
Receiving Station*

Master Station Master Station/Telephone
/Outgoing Call Access
Number

No setting

"Time-Based Call
Forwarding" Receiving
Station*

Master Station Master Station/Telephone
/Outgoing Call Access
Number

No setting

"Busy Call Forwarding"
Receiving Station*

Master Station Master Station/Telephone
/Outgoing Call Access
Number

No setting

"No-Answer Call
Forwarding" Receiving
Station*

Master Station Master Station/Telephone
/Outgoing Call Access
Number

No setting

* This setting can be performed at the master station as well. Refer to the section describing each call
forwarding function.
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Outside Line

Outside Line
Connection Time-Out

Exchange 1 – 99 minutes 3 minutes

Outside Line Name Each Outside
Line

8 alphanumeric characters No setting

Outgoing Call Access
Number

Each Outside
Line

0 – 9 No access
No. set.

Direct-In Dialing Each Outside
Line

Enabled/disabled Disabled

Direct-In Line Each Outside
Line

Enabled/disabled Disabled

Subject Item Unit Setting Range Initial Value

Substation

Station Number Substation 00 – 999999
From the selected exchange's
first station No. to the No.
immediately preceding the next
exchange's first station No..

10 – 73

Station Name Substation 8 alphanumeric characters Station No.

Called Station
Exchange Number

Substation Exchange No. of the master
station (telephone)

1

Called Station Line
Number

Substation Line No. of the master station
(telephone)

1

Called Station Number Substation Station No. of the master
station(telephone)

10

Called Station Name Substation Station Name of the master
station(telephone)

10

Call Priority Substation Normal/Emergency Normal

Receiving Station
(Rep/Member)
Exchange Number

Each Outside
Line

Exchange No. of the master
station (telephone)

No setting

Receiving Station
(Rep/Member) Line
Number

Each Outside
Line

Line No. of the master station
(telephone)

No setting

Receiving Station
(Rep/Member) Station
Number

Each Outside
Line

Station No. of the master
station (telephone)

No setting

Receiving Station
(Rep/Member) Station
Name

Each Outside
Line

Station Name of the master
station (telephone)

No setting
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7.3. Function Settings

Function Item Unit Setting Range Initial Value

Group Call

Member Station
Exchange Number

Master Station
Exchange No. of the master
station (telephone)

No setting

Member Station 
Line Number

Master Station Line No. of the master station
(telephone)

No setting

Member Station
Station Number

Master Station Station No. of the master
station (telephone)

No setting

Member Station
Station Name

Master Station Station Name of the master
station (telephone)

No setting

Call
Forwarding
/Time-Out

Call Forwarding Exchange Enabled/disabled Disabled

Time-Based Call
Forwarding

Exchange Enabled/disabled Disabled

Time-Based Call
Forwarding Start Time

Exchange 00:00 – 23:59 No start time

Time-Based Call
Forwarding End Time

Exchange 00:00 – 23:59 No end time

Busy Call Forwarding Exchange Enabled/disabled Disabled

No-Answer Call
Forwarding

Exchange Enabled/disabled Disabled

No-Answer Call
Forwarding: Calling
Interval

Exchange 1 – 99 seconds 10 seconds

Call Time-Out Exchange Enabled/disabled Disabled

Conversation Time-Out Exchange Enabled/disabled Disabled

Conversation Time-
Out: Conversation
Time Limit

Exchange 10 – 990 seconds 10 seconds

Call Time-Out: Calling
Interval

Exchange 1 – 99 minutes 1 minute

Paging

Zone Number Digit Exchange 1 – 2 digits 1 digit

Paging Time-Out Exchange 10 – 990 seconds Disabled

Zone Paging Zone Enabled (V)/disabled (–) (–)

Scan Monitor

Monitoring Time Master Station 1 – 99 seconds 5 seconds

Monitoring Station
Exchange Number

Master Station Exchange No. of the
substation

No setting

Monitoring Station
Station Number

Master Station Station No. of the substation No setting

Monitoring Station
Station Name

Master Station Station Name of the
substation

No setting

Monitoring Station 
Line Number

Master Station Line No. of the substation No setting

Public Address
System

Zone Exchange Enabled (V)/disabled (–)
(–)

External
Source
Distribution

Zone Each
Activation
Input

Enabled (V)/disabled (–) (–)
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7.4. Other Settings

Function Item Unit Setting Range Initial Value

Dialing
Assignment

One Shot Make Time Master Station 1 – 9 seconds 3 seconds

Dial Master Station Up to 16 Digits No setting

Name Master Station 8 alphanumeric characters No setting

Door Lock (Switch No.) Master Station 1 – 1024 No setting

Emergency
Conference

Member Station
Exchange Number

Master Station Exchange No. of the master
station (telephone)

No setting

Member Station 
Line Number

Master Station Line No. of the master station
(telephone)

No setting

Member Station
Station Number

Master Station Station No. of the master
station (telephone)

No setting

Member Station
Station Name

Master Station Station Name of the master
station (telephone)

No setting

Direct Select
Control Output Mode Exchange Response-Activate

/Call-Activate
Response-
Activate

Function Item Unit Setting Range Initial Value

Function Item Unit Setting Range Initial Value

Remote
Dialing

Remote Dialing Whole – –

Log Data Whole – –

Communication
Monitoring

Whole – –

Data Upload Whole All Exchanges
/Single Exchange

All
Exchanges

Printout Printout Whole All Exchanges
/Single Exchange

All
Exchanges

Log Data

Communication
Monitoring

Upload
/Download

PC Port

PC-to-Exchange
connection method

Whole RS-232C/Modem RS-232C

Data Download Whole All Exchanges
/Single Exchange

All
Exchanges

Communication Port
(When RS-232C is
connected)

Whole
COM1 – COM4 COM1

Telephone Number
(When Modem is
connected)

Whole
Up to 20 Digits No setting

7.5. AI-900DI Setting
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8. MESSAGES

8.1. Confirmation Messages

No.

1

2

3

4

5

Display Message

[Text changed. Exit?]

[Will delete all list data. OK?]

[Set file not saved. Exit?]

[Reading log data. Will stop
reading.]

[Reading communication
data. Will stop reading.]

Explanation

This message appears when the [Close] button is pressed while
editing data.

This message appears when the [Delete ALL] button is pressed.

This message appears when an attempt is made to exit the current
mode without saving the file.

This message appears when a log data request is canceled while in
process.

This message appears when a communication data request is
canceled while in process.

No.

1

2

3

4

5

6

7

8

9

10

11

12

Message

[Incorrect first station No.]

[Duplicated first station No.]

[Incorrect first station No.
digit length]

[First station No. is greater
than that of the next
exchange]

[Incorrect exchange No.]

[Incorrect starting time.]

[Incorrect ending time]

[Incorrect call time (sec)]

[Incorrect call time (minute)]

[Incorrect conversation time
(sec)]

[Incorrect station No.]

[Duplicated station No. (B) for
Exchange A]

Explanation

The first station number is incorrect. Check to confirm the set digit
length of the station number.

More than one first station number has been detected.

Check to confirm the first station number and its digit length.

The selected exchange's first station number is set to be larger than
the next exchange's first station number.

The exchange number has been set outside its valid range. Reset the
exchange number to within the set total number of exchanges. (1-
Total number)

The Absence Call Transfer interval start time has been set to an
invalid number.

The Absence Call Transfer interval end time has been set to an
invalid number.

The No-Answer Transfer call interval has been set to an invalid
number.

The Calling Interval Limit has been set to an invalid number.

The Conversation Time Limit has been set to an invalid number.

Station number setting error.
Master station: 

The station number digit length is incorrect.
Substation:

The station number digit length is incorrect.
The station number is not set within the range that begins with the
selected exchange's first designated station number and ends at
the number immediately preceding the next exchange's first station
number

More than one Station B (actual station number displayed) has been
detected as being connected to Exchange A (actual exchange
number displayed).

8.2. Setting Error Messages
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No.

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27

28

29

30

31

32

33

Message

[Incorrect station No. digit
length (B) for exchange A]

[Station No. (B) for Exchange
A exceeds station No. limits.]

[Incorrect name]

[Incorrect Auto C/O Xfer sta]

[Dialing incorrect exchange-
equipment No. (A-B)]

[Incorrect master equipment
No.]

[Invalid master equipment
No. (A-B) is set.]

[Invalid master equipment
No. is set.]

[Incorrect sub-equipment
No.]

[Invalid sub-equipment No.
(A-B) is set.]

[Invalid sub-equipment No. is
set.]

[Incorrect C/O line
connection time-out.]

[Specific No. for making a
call is not correct.]

[Redundant receiving
stations (A-B).] 

[Center station is not set for
the direct-in group.]

[Duplicated exchange-
equipment No. (A-B).]

[Incorrect monitoring time.]

[Incorrect telephone No.] 

[Incorrect password]

[Old password not correct.]

[New password not correct.]

Explanation

The digit length of the number corresponding to Station B (actual
number displayed) connected to Exchange A (actual exchange
number displayed) is incorrect.

Station number B (actual station number displayed) connected to
Exchange A (actual exchange number displayed) is not set within the
range that begins with the selected exchange's first designated
station number and ends at the number immediately preceding the
next exchange's first station number.   

The file name is either too long or contains an invalid character.

The telephone number of the receiving station to which telephone
calls are automatically transferred is either too long or contains a non-
numerical character.

Master station calling error.
The exchange or equipment number is incorrect.
The exchange or equipment number is incorrect.

A: Exchange number, 
B: Master station equipment number

The master station equipment number is incorrect.

Invalid substation numbers have been set.
A: Exchange number, 
B: Master station equipment number

Invalid master station numbers have been set.

The substation equipment number is incorrect.

Invalid substation numbers have been set.
A: Exchange number, 
B: Substation equipment number

Invalid substation numbers have been set.

An incorrect time value has been entered for the Telephone
Conversation Time Limit.

An incorrect number has been set for access to outgoing telephone
calls.

More than one Master Station Equipment B (actual number
displayed) has been detected as being connected to exchange A
(actual number displayed) in the telephone call receiving station
setting

A center station has not been designated for the Call Receiving
station group.

More than one Equipment B (actual number displayed) has been
detected as being connected to Exchange A (actual number
displayed).

An incorrect monitoring interval has been set for the Scan Monitor.

The entered telephone number is either too long or contains a non-
numerical character.

The password is not correct.

The old password entered when changing the password is incorrect.

The password entered for confirmation does not agree with the "new"
password entered when changing the password.
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34

35

36

37

38

39

40

41

42

43

44

Message

[Not registered.]

[Incorrect dial number]

[Incorrect zone No. digit
length]

[Incorrect paging time-out]

[Failed to transmit.]

[Failed to open the device.]

[Communications time-out]

[Log Data File could not be
opened.]

[Communication Monitoring
File could not be opened.]

[Log Data File could not be
written.]

[Communication Monitoring
File could not be written.]

Explanation

An invalid master stations has been designated in the Remote Dial
settings.

The digit number to be set for the Direct Select Dial setting exceeds
16 digits (allowable range: 1 – 16 digits).

The paging zone number is too long.

An incorrect paging time limit has been set.

Data could not be correctly transmitted.

A connected device cannot be opened. Please check the COM port
connection.

Data was not correctly received.

It is impossible to open the log data file. 

It is impossible to open the communication monitoring log file.

The log files cannot be written.

The communication monitoring log files cannot be written.

Printed in Japan
133-06-240-10


